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Satmaster Pro Mk9.x Quick Start User Guide

Satmaster Pro is designed to run on Windows XP/Vista/7/8. This is a quick start 
guide in using the software. More detailed technical Information is supplied in the
help file distributed with the full product.  Some functions described below may 
be disabled in demo versions. Satmaster Pro assumes the user has an outline 
knowledge of link budgets and the various parameters applicable.

For sales/support enquiries relating to this product please contact: 

Arrowe Technical Services using the email contact form on any of the website 
URLs below.

http://www.arrowe.co.uk
http://www.arrowe.com
http://www.satmaster.co.uk
http://www.satmaster.com

Overview
Satmaster Pro is a general purpose tool for the satellite industry. Signal 
propagation, antenna aiming (including dual feeds), link budget analysis and 
solar outage prediction provide the backbone to the package. At the end of this 
document, a method is described where you may  prepare paired carrier link 
budgets.

Other features, include integral magnetic variation calculation and tens of 
thousands of stored town/city co-ordinates for over 200 countries. All the non-file 
based input forms are pre-filled with example data, which you may customise. 

Installation

CD Version: Insert CD into drive and open the drive folder. Double click 
‘setup.exe‘ and follow the simple on-screen instructions.

Web Demo Version: Download the self extracting file from the website and run 
it.  Follow the on-screen instructions and respond to the prompts for destination 
hard disk folder etc.

The install program decompresses files to your hard disk and sets up a program 
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menu group containing Satmaster Pro.  You run the program by double clicking 
the desktop shortcut or selecting form Windows main menu. Satmaster Pro is 
uninstalled using the “Add/Remove Programs” tool in the Control Panel.

Running Satmaster Pro
Satmaster Pro is designed to be simple to use and works just like any other 
Windows application with  menus, speed buttons, dialog boxes (forms),  
windows, a status bar and an HTML help system.

The program starts with a main application window, menu and toolbar.  The 
toolbar gives access to the File, Edit, View, Map, Graph, Table, Calculate, 
Option, Window and Help menus.

The data file types Satmaster Pro uses are:

• Look Angle Files (*.ang) – Antenna aiming.

• Dual Feed Files (*.duo) – Dual feed calculations.

• Link Budget  (*.glb) – GEO full up-down digital link budget (bent-pipe)

• Country Files (*.twn) – Country files with town/city data

• Satellite File (*.geo) – The GEO satellite list

• Solar Outage (*.sun) – Sun outage results file

• Bitmap Files (*.bmp;*.gif;*.pcx;*.tif;*.jpg) – Footprint maps etc.

• Rain Attenuation Files (*.atn) – Rain attenuation data files

• Regenerative Uplink Budget (*rup) – Digital budget for regenerative 
transponder uplinks (GEO or NON GEO supported).

• Regenerative Downlink (*rdn) – Link budget for regenerative transponder 
downlinks (GEO or NON GEO supported). This module may also be used 
for quick TVRO antenna sizing where a bent pipe transponder is operated
near saturation,

• Link Budget (Non GEO) (*llb) – Link budget for HEO/MEO/LEO satellites 
(bent-pipe)

• Batch GEO Link Budget (*mlk) – Control file for batch link budgets.

• Two Line Element Files – NORAD TLE files (*.tle)

You may open any mix of these file types (memory permitting).  You can display 
many windows simultaneously to compare different links and their performance 
characteristics.

 The database files, (*.geo) and (*.twn), are fully editable and may be modified or
appended by the user at any time.  To save time the latest file ‘satlist.geo’ can 
also be downloaded from our web site.
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System Clock
Ensure the date of your system clock is correct, so current magnetic variation 
values may be calculated. It should be noted that the best possible accuracy, 
using any global model, is + or - 0.25 degrees.

Data Conventions
Satmaster Pro requires the following rules to be observed when entering or 
interpreting values of latitude, longitude or magnetic variation.  All units are 
degrees unless otherwise stated.

• Latitudes NORTH  suffixed by N (eg 53.33N)
• Latitudes SOUTH  suffixed by S  (eg 10.34S)
• Longitudes EAST suffixed by E  (eg 19.2E)
• Longitudes WEST suffixed by W (eg 3.1W)
• Magnetic variation EAST  suffixed by E (eg 3.0E)
• Magnetic variation WEST suffixed by W (eg 3.0W)

Latitudes and longitudes, are usually obtained from maps and atlases in degrees
& minutes format, whilst satellite longitudes are often quoted in decimal degrees.
When using Satmaster Pro, always use decimal degrees for all input fields with 
the exception of editing country files outlined below.

A convenient conversion facility is provided under the “Calculate” menu to 
convert from the degrees and minutes form to degrees.

When editing country data files it is more convenient to enter and check data in 
degrees and minutes format.  Satmaster Pro automatically converts degrees and
minutes format to decimal degrees as and when the data is used.

Help Facilities

A help system is employed using a variety of methods listed below:

• Each dialog box (form), has its own help button which may be clicked to 
display detailed information about input values.

• Press F1 key for context sensitive help on any input field.
• Click the 'question mark' (?) button on top right of a form then click the 

field of interest.

Input Forms
Satmaster Pro makes heavy use of input forms (dialog boxes). This makes input 
validation comprehensive and allows the user to call up help as necessary for 
assistance with range, type and definition of input parameters.  All input is 
validated in an attempt to make the program ‘crash-proof’ and rejects bad input 
data where possible. 

You may cancel (close) a partially completed form at any time and provided you 
do not close it's associated window,  data will be retained on clicking the “Edit 
Active Document” button again. You may also save incomplete forms.
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Toolbar
The toolbar buttons duplicate the more frequently used menu selections.  The 
most useful is the ‘Edit Active Document” button, third from left, It saves a lot of 
menu thrashing! The toolbar supports the yellow “tooltips”. In order, left to right, 
the buttons represent:

Load an existing file; Save file; Edit active document; Copy all; Print; Print 
preview; Tile open windows; Cascade open windows; Help. 

Getting Started
Here is a summary of using Satmaster Pro.

Edit Active Document toolbar button.

For any file type, either new or opened, bring up the input form by clicking the 
“Edit Active Document” button shown above, complete the form then click it's OK
button to  calculate. Provided you do not close the associated window, you may 
also leave any, file based, input form at any time without loosing partially 
completed data by clicking the Cancel button. To restore the form click the “Edit 
Active Document” button again. The edit button, shown above, is easily the most 
useful, and convenient, button on the toolbar.  You can edit any file window, at 
any time, by clicking this button.  Pressing the “F12” hot key performs the same 
action.

Default parameter sets are not necessary, simply load a parameter file that is 
closest to that needed, edit the parameters that are different then save it under a
different file name This is much quicker than starting with a new blank file.

When a report, footprint, graph or table is displayed in an active window, simply 
click the “Copy” button to transfer the entire contents to the clipboard in a single 
operation.  The clipboard contents can subsequently be pasted into a 
spreadsheet with minimal editing.

Satmaster Pro can also read BMP, TIFF, PCX and JPEG formats, which may be 
useful to display EIRP, G/T and SFD footprints (for copyright reasons these are 
not redistributed with Satmaster Pro).
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Options Menu

The first thing to do is enter your company name into the Set-up dialog box.  This
text is inserted in all printouts and displays.

• Click on ‘Options’ from the menu bar then select ‘Setup’.  The persistence 
of the set-up data  is selected using one of three "Persistence" radio 
buttons shown below.

• ‘This session only’ - any changes made to the set-up dialog are temporary
and last only for the duration of the current session. 

• ‘All sessions’ - any changes made to the set-up dialog take effect 
immediately, as above, but are also saved to disk as the file ‘satmast.cfg’. 
Next time you run Satmaster Pro, these values and selections will be 
restored.

‘Restore defaults’ - this restores the default settings when you first installed 
Satmaster Pro. Checkboxes are provided for saving all data present in the input 
forms under the Table, Graph and Calculate menus

File Menu
Use this option to save, open, print, or create new files.  There are many different
file types.  If you select File|New the appropriate form is displayed for the file 
type selected.  Simply complete it referring to Help where necessary.

To open an existing file select ‘File|Open’ to display the open dialog then select 
the file type from the ‘List Files of Type’ section.

Editing Files
The following sections show how to produce a selection of files followed by how 
to create and edit the country and satellite databases.  Creating and editing any 
other file type follows the same method.

Look Angle Files  (*.ang)
This file type is used to calculate antenna installation settings.  Click on File|New 
then select “New Look Angles” from the menu to display an empty ‘Look Angles’ 
window and input form.  Later you may probably find it more convenient to 
amend a previously saved file and just alter the parameters for your particular 
location.  Remember to save it under a different filename though.

For convenience, you may transfer data from the country town/city database into 
the ‘Look Angles’ form with the ‘Site’ button. Clicking this button will bring up an 
‘Open Country Data File’ dialog for you to select a particular country file.  
Entering a letter from the keyboard can quick scroll the list box to the appropriate
alphabetical point.

Once the country file has been selected, a list box is displayed for you to select a
town or city from the file.  Entering a letter from the keyboard scrolls the list box 
quickly to the appropriate alphabetical point.
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Similarly, data from the satellite database file ‘satlist.geo’ may be transferred into
any dialog equipped by clicking the ‘Satellite’ button and double clicking on the 
required satellite in the list box.  Again, entering a letter from the keyboard can 
quick scroll the list box.

When you have completed the ‘Look Angles’ dialog click the OK button to trigger 
the calculation.  You may also close the input form without loosing any entered 
data by clicking the ‘Cancel’ button provided you do not close the associated 
display window. By reactivating the accompanying window and either selecting 
‘Edit Active Document’ from the ‘Edit’ menu or clicking the toolbar button you 
may finish entering your data. This facility is also applicable to all the link budget 
and solar outage forms.

Once you have triggered the calculation, the associated window displays the 
calculated data and the parameter file may be saved with the ‘ang’ extension.  
To do this, select ‘Save As’ from the ‘File’ Menu which displays the appropriate 
dialog box and enter a filename.  It should be pointed out, that only the input 
parameters are saved, not the text itself.  If you wish to save the text portion as a
simple text file then select 'File|Save As Text’ or 'File|Save as HTML' . You may 
also copy the text to the clipboard, as ‘tab delimited text’, for directly pasting into 
a spreadsheet or similar application. 

Link Budget Files
There are several types of link budget file.  The regenerative downlink module 
has a dual purpose. It may also be used for quick TVRO antenna sizing 
providing the bent pipe transponder is operated near saturation. Obviously, by 
performing a downlink calculation in isolation you need to make a few 
assumptions, but for broadcast TV reception, the error is small and adequate for 
sizing downlink antennas. For satellite TV, the uplink side uses UPC (uplink 
power control) or ALC (automatic level control) in an attempt to reduce the 
effects of uplink rain on the downlink.

The procedure for editing and completing link budget forms is similar to that of 
the ‘Look Angles’ example.  Simply complete, referring to Help as necessary 
then click the OK button to trigger the calculation.

On all link budget forms, there is an option to enter either antenna efficiency or 
gain.  To enter a gain prefix the value entered with a ‘+’ character.  This option is 
useful where the gain of the antenna is already known. Likewise you can choose 
whether to enter an LNA/LNB noise figure or noise temperature. To enter a noise
temperature prefix the value entered with a '+' character.

The rain models are fully automated, no reference maps are required. ITU-R 
P618 rain model is used thoughout.

Some isolated downlink budgets have options for optimising for a minimum 
receive antenna size. It should be realised that the adjacent satellite interference 
(ASI) will also increase as the antenna size reduces. When the “Antenna Size 
Optimisation” tab is clicked it allows you to select the type of antenna size 
optimisation to adopt as shown above.  With small dishes the level of ASI  is 
often more dominant than power requirements for determining the minimum 
antenna size.
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Link Budget Files (GEO)

Use this module for the vast majority of digital link budgets. It performs up-down 
link budgets for VSAT networks,  digital links for SNG as well as most other 
applications. This module can iterate the link budget for minimum uplink power 
requirements.

To use this module open a new digital uplink file or, perhaps easier, modify an 
existing file.  Complete the form referring to ‘Help’ as necessary. Under the 
‘Graph’ menu there is a reference chart to obtain values for Eb/No for various 
code rates and modulation schemes.

Click the tabs to select portions of the form. The overall design relies only on 
information easily available or estimated.

There is “Reverse” button on the input form which toggles (exchanges) some site
dependent input parameters from the uplink to the downlink. This can save some
typing when a link budget needs to be performed for the reverse link in a network
situation. 

Under the "Carriers and Modulation" tab you can select from BPSK (1 
bit/symbol), M-PSK or M-QAM modulation.  If 1bit/symbol  is selected always 
enter M=2 since it is a binary signalling system.

Other Link Budget Files

With the non-geo satellite link budgets you will need a figure for range and 
elevation to create a “snapshot” link budget. Otherwise operation is very similar 
to those already described. Remember to press F1 on any input parameter for 
help.

Common Causes of Failure to Balance a Link Budget
There are three main reasons why negative margins or failure to balance a link 
budget may occur while using Satmaster Pro.

1. With digital link budgets, ensure you have entered the information rate in units
of Mbps not kbps. This is a common mistake.

2. Entering an excessive signal availability value. If in trouble always start off with
a low availability of, say, 99.3% and work upwards.

3. Entering too lower a value for interference fields. The lower the numerical 
value entered, the higher the interference.

Dual Feed Files
These files are similar to look angle files but also calculate the relative satellite 
spacing and (x,y) feed mounting positions for dual feed systems.  You can use 
the resulting antenna efficiency reduction to perform a second link budget if need
be. Repeat as often as necessary for multiple feed systems.
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Rain Attenuation Files
This module calculates the attenuation, system noise increase and downlink 
degradation due to rain for any given slant path. As with all the link budget 
modules a choice of using either the ITU or Crane model is catered for.

Solar Outage Files
Twice a year the sun crosses the equator and traces an arc that is directly 
behind the geo-arc of satellites.  Noise from the sun, within capture of the 
antenna’s beamwidth, disrupts reception.  The effect is known as a solar outage.

Satmaster Pro employs a complex algorithm to calculate the sun's position rather
than rely on approximation methods. Events are listed in date order and grouped
into early and late seasons.

Sun files (*.sun) are used to store solar outage input parameters.  Completing a 
solar outage form is similar to that of previous examples, the parameter files can 
be opened and saved in a similar manner.

Within the edit dialog select either ‘standard’ or ‘wide’ beamwidth.  The region of 
sky scanned depends on the specified antenna beamwidth of the receive station.
If an even wider ‘window’ is required, reduce the antenna diameter parameter to 
increase the beamwidth.  The default prediction is accurate to the ‘nearest 
minute’, however there is a ‘nearest second’ option.

Clicking the ‘OK’ button starts the calculation, which may take some time 
calculating with slower processors.

Note: If the program does not find any outages, the most likely reason is that the
time zone entered, relative to the Greenwich meridian, is incorrectly input.  Time 
zones west of the Greenwich Meridian are entered negative and time zones east,
positive. Do not include any 'daylight saving' schemes in this. 

How to Edit Country Data Files
Country data files contain latitude and longitude site co-ordinates for major towns
and cities.  There are about 250 country files with up to 1800 entries in each.  
This data can be used either to edit forms equipped with a ‘Site’ button or 
generate various tables such as ‘International Look Angles’ under the ‘Tables’ 
menu.  Select ‘File|New|New Country Data’ to start a new file, you may want to 
create a custom list of earth stations you regularly link with.

To edit an existing country file:

1. Click ‘File’ then ‘Open’.  The Open dialog is displayed.
2. Select ‘Country Files (*.twn) from the ‘List Files of Type’ pull down listbox.
3. Select the file of the country of interest (e.g. United Kingdom.twn).  A window 

should appear containing a list of all the towns and cities currently stored.
4. Click the toolbar edit dialog button or select ‘Edit Active Document’ from the 

‘Edit’ menu.  The ‘Edit Town/City Data’ dialog appears (shown below).
5. Click on the name of the town/city you wish to amend then click the modify 

button (double clicking on the town/city goes straight to modify).  The ‘Modify 
Town/City Record’ dialog appears.  You can also change the name of the 
country as it appears on reports and printouts by clicking the ‘Edit Country 
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Name’ button.
6. Edit the Town/City name and co-ordinates as necessary then click the ‘Done’ 

button.

Modify town/city records by clicking the ‘Modify’ button or add records by clicking 
the “Add” button. Click the “Done” button after modification then save the file 
using 'File|Save As' from the program’s menu.

How to Edit Satellite Data File
A database of geo-stationary satellites, their locations and active bands are 
stored in a single file called ‘satlist.geo’.  Select File|Open then select ‘Satellite 
File (*.geo)’ from the ‘list files of type’ drop down list box in the ‘Open’ file dialog. 
Select the file ‘satlist.geo’ and its contents will be displayed in a window.  Click 
the edit toolbar button to edit in a similar manner to the town/city files.  This file is
used with the 'Satellite' button in many input forms and to generate lists of 
satellites ‘visible’ from a chosen location.  

Display Footprint Maps (*.bmp; *.gif; *.tif; *.jpg)
Footprint maps (not included in the package for copyright reasons) may be 
opened by selecting ‘File’|’Open’ then listing ‘Bitmaps *.*’ in the ‘Open File’ 
dialog.  A more convenient way is by selecting ‘Map|Display Footprint Map’  form 
the menu bar.

Footprint maps may be obtained from satellite operator’s web sites or scanned 
from any publication you wish. Also many independent web sites have a large 
collection of EIRP footprints such as http://www.satbeams.com. Satmaster Pro 
will display BMP, GIF, TIFF and JPEG formats.

Map Menu
There are two reference diagrams under the 'Map' menu, one is called ‘Polar 
Mount Diagram’ and the other is ‘Polarization Offset Diagram’.  These diagrams 
clarify the angle terminology used. There are also reference maps for time zones
and ITU regions.

Graph Menu
The ‘Graph’ menu allows you to plot various relationships between parameters 
and may be useful for reference purposes.  Select the required graph from the 
‘Graph’ menu and fill in the corresponding form.  Any data entered into these 
forms are persistent. If you do not need the current data then click the input 
form's ‘Clear’ button.  Context sensitive help is available on all fields. Each graph
is plotted in a new window and may be either printed out or copied to the 
clipboard. The graphs show general trends, they are not intended for accurately 
extracting values.

Table Menu
Select the required table from the ‘Table’ menu, fill in the displayed form 
associated with it and click the OK button.  As described in the previous section 
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entered data can be persistent. The table of results is displayed in a new window
and may be either printed, saved as an unformatted text or HTML or copied to 
the clipboard as tab delimited text. The status bar also displays the order of the 
table columns.  This may be helpful if the table headings are scrolled out of view

Particularly useful options under the ‘Tables’ menu are ‘International Look 
Angles’ and ‘Dual Feed Spacing’.  For all major towns and cities in a selected 
country, the former builds a table of look angles to a particular satellite and the 
latter a table of relative satellite and feed spacing.  A further useful table is 
‘Satellites Above Horizon’ which generates a table of look angles for all satellites 
‘visible’ from a particular site.

Solar Event Tables
There are two types of solar event table generated by selecting from the ‘Table’ 
menu.  The first is ‘Solar Transit Times’ and the second is ‘Sun/Satellite Azimuth 
Coincidence’.  The former is useful for accurately locating true north/south for 
installing polar mount antennas when using the 'stick in the ground' shadow 
method.  The latter may be useful for locating the true azimuth of a satellite if a 
compass is not to hand or local magnetic fields are affecting it’s reading.  Both 
tables share the same “Edit Solar Event Form’ dialog shown below.

The input form entry in need of further explanation is labelled ‘Solar transit or 
satellite longitude’.

If you require a table of solar transit times, this entry should be identical to that 
entered for the site longitude.  That is to say, the times are calculated when the 
sun crosses the site’s local meridian.  This can be thought of as the longitude of 
a “virtual” satellite directly south of your location (north in the Southern 
Hemisphere).

On the other hand, if you require a table of times when the sun’s azimuth is the 
same as that of a target satellite, from your location, then that satellite’s longitude
or orbital slot should be entered instead.  Satmaster Pro will automatically detect 
which has been entered and display the appropriate table.

Calculate Menu
Here there are several modules to perform commonly required calculations and 
conversions such as, noise temperature to noise figure, degrees and minutes to 
degrees, wavelength to frequency etc. Click 'OK' button to recalculate or 'Cancel'
to terminate.

Expression Evaluator

The expression evaluator (under the ‘Calculate’ menu) allows you to evaluate a 
mathematical expression entered as a string of characters to a numerical result.

The operator precedence is as follows
- Negate

           * Multiply
/ Divide
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          + Add
- Subtract

    ^ Raise to the power
You may override the normal operator precedence with parentheses.  For 
example: f=(b+c)/a forces b+c to be evaluated before dividing by a.

The following functions are supported; the arguments must be enclosed in 
parentheses.  For example sin(45).  With trigonometric functions, you can select 
either degree or radian mode by selecting the appropriate radio button.

abs absolute value
acos arc cosine (inverse cos)
asin arc sin (inverse sin)
atan arc tan (inverse tan)
cos cosine
cosh hyperbolic cosine
exp exponential
log logarithm (base 10)
logt logarithm (base 2)
ln logarithm (base e)
sin sine
sinh hyperbolic sine
sqr square root
tan tangent
tanh hyperbolic tangent

The constant 3.14159258 is entered into an expression as either ‘pi’ or ‘p’.

Window Menu
This menu helps you organize the application’s windows.  Choosing ‘Cascade’ 
arranges all open windows in a staggered and overlapped fashion.  Choosing 
‘Tile’ shrinks and arranges all open windows into a tile design either vertically or 
horizontally as requested.  If ‘Arrange Icons’ is selected it tidies up and arranges 
all the minimized icons at the bottom of the main application window.  ‘Close All’ 
closes all open windows and leaves a clear application window.  There are also 
toolbar buttons for ‘Cascade’ and ‘Tile Vertically’.

Help Menu
Selecting “Help Contents” offers more detailed information on how to use 
Satmaster Pro Pro and background information on various technical and 
practical topics.  

Copying Output to Spreadsheet Programs
The entire contents of any window may be copied to the clipboard in a single 
operation as tab delimited text.  Selecting “Edit|Copy” or clicking the toolbar’s 
copy button initiates this process.  Output can then be pasted directly into a 
spreadsheet application, such as Excel, for quick customisation without re-
formatting.
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Drag and Drop
Satmaster Pro supports the drag and drop standard of loading its file types into 
the main application windows. Windows shell features, such as “open” and “print”
are enabled.

Most Recently Used Files

Under the ‘files’ menu there is a list of the six most recently used files.  This 
enables quick opening of any of these files without the need to bring up the open
file dialog. 

Feedback to Author
Satmaster Pro is often improved.  Your comments, criticisms and suggestions 
are always helpful.  If any errors are detected please let me know. Contact 
details are at the head of this document.

How To Prepare Paired Carrier Link Budgets.

This type of link budget may require a special mention as it differs significantly 
from from regular link budgets. Paired Carrier is an adaptive cancellation 
technology that allows two carriers to simultaneously occupy the same 
transponder bandwidth. Paired carriers are affected by the same interference 
and atmospheric factors as normal carriers.  Although up to 50% reduction in 
bandwidth usage would appear possible, this is not strictly true since there is an 
extra degradation, associated with each of the pair,  due to interference between 
the two.  That aside,  significant bandwidth savings are possible by using paired 
carrier technology. Link budgets using this techniology can be prepared using 
Satmaster Pro by using the following guide.

1. Using File|New from main menu, open two Link Budget instances so you 
have a separate link budget for each direction inbound and outbound to 
hub.

2. Enter all the usual link budget (LB) input parameters paying special 
attention to the 'Implementation loss' input field under the 'Carriers' tab. 
Your modem manufacturer may supply guidance on the relevant values to
enter for the extra degradation to be expected with paired carrier 
arrangements.

3. Screen resolution permitting, you may arrange the two link budget 
windows, inbound and outbound, side by side using 'Window|Tile 
Vertically' from the main menu.

4. The balancing of the two link budgets is a manual iterative process which 
is dependent on the initial results. A number of parameters (G/T, FEC and
modcod) may be changed in an attempt to make the link more bandwidth 
limited and less power limited. 
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5. Whenever a change is made then the two link budgets are run again to 
check the wanted to interferer beam peak power spectral densities are 
within ± 7dB of each other and the symbol rate ratio of the two carriers 
should be a maximum of 3:1 or 1:3 .There is an optional input for 
transponder EIRP beam peak so that the carrier beam peak values for 
PSD and EIRP are calculated
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